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I. Introduction 
 

This document explains how PerkinElmer’s UV Lab Security software assists in meeting 

the regulation of 21 CFR Part 11 for electronic records and electronic signatures. 

  
1.  21 CFR Part 11 Compliance 
 

Title 21 CFR Part 11 of the Code of Federal Regulations includes the Food and Drug 

Administration’s (FDA) guidelines on electronic records and electronic signatures in the 

United States. Part 11, as it is commonly called, defines the criteria under which 

electronic records and electronic signatures are considered to be trustworthy, reliable 

and equivalent to paper records. 

 

1.1  Subpart A. General Provisions  

  

Sec. 11.1.  Scope 

 
1. The regulations in this part set forth the criteria under which the agency considers 

electronic records, electronic signatures, and handwritten signatures executed to 

electronic records to be trustworthy, reliable, and generally equivalent to paper records 

and handwritten signatures executed on paper. 

 
2. This part applies to records in electronic form that are created, modified, maintained, 

archived, retrieved, or transmitted, under any records requirements set forth in agency 

regulations. This part also applies to electronic records submitted to the agency under 

requirements of the Federal Food, Drug, and Cosmetic Act and the Public Health Service 

Act, even if such records are not specifically identified in agency regulations. However, 

this part does not apply to paper records that are, or have been, transmitted by 

electronic means. 

 
3. Where electronic signatures and their associated electronic records meet the 

requirements of this part, the agency will consider the electronic signatures to be 

equivalent to full handwritten signatures, initials, and other general signings as required 

by agency regulations, unless specifically accepted by regulation(s) effective on or after 

August 20, 1997. 
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4. Electronic records that meet the requirements of this part may be used in lieu of paper 

records, in accordance with 11.2, unless paper records are specifically required. 

 
5. Computer systems (including hardware and software), controls, and attendant 

documentation maintained under this part shall be readily available for, and subject to, 

FDA inspection. 

 
6. This part does not apply to records required to be established or maintained by 1.326 

through 1.368 of this chapter. Records that satisfy the requirements of part1, subpart J 

of this chapter, but that also are required under other applicable statutory provisions or 

regulations, remain subject to this part. 

 

Sec. 11.2.  Implementation 

 
1. For records required to be maintained but not submitted to the agency, persons may 

use electronic records in lieu of paper records or electronic signatures in lieu of 

traditional signatures, in whole or in part, provided that the requirements of this part 

are met. 

 
2. For records submitted to the agency, persons may use electronic records in lieu of 

paper records or electronic signatures in lieu of traditional signatures, in whole or in 

part, provided that: 

 
a. The requirements of this part are met; and 

 
b. The document or parts of a document to be submitted have been identified in     

public docket No. 92S-0251 as being the type of submission the agency accepts in 

electronic form. This docket will identify specifically what types of documents or 

parts of documents are acceptable for submission in electronic form without paper 

records and the agency receiving unit(s) (e.g., specific center, office, division, 

branch) to which such submissions may be made. Documents to agency receiving 

unit(s) not specified in the public docket will not be considered as official if they 

are submitted in electronic form; paper forms of such documents will be 

considered as official and must accompany any electronic records. Persons are 

expected to consult with the intended agency receiving unit for details on how 

(e.g., method of transmission, media, file formats, and technical protocols) and 

whether to proceed with the electronic submission. 
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Sec. 11.3.  Definitions 

 
1. The definitions and interpretations of terms contained in section 201 of the act apply to 

those terms when used in this part. 

 
2. The following definitions of terms also apply to this part: 

 

a. Act means the Federal Food, Drug, and Cosmetic Act (secs. 201-903 (21 U.S.C. 

321-393)). 

b. Agency means the Food and Drug Administration. 

c. Biometrics means a method of verifying an individual's identity based on 

measurement of the individual's physical feature(s) or repeatable action(s) where 

those features and/or actions are both unique to that individual and measurable. 

d. Closed system means an environment in which system access is controlled by 

persons who are responsible for the content of electronic records that are on the 

system. 

e. Digital signature means an electronic signature based upon cryptographic methods 

of originator authentication, computed by using a set of rules and a set of 

parameters such that the identity of the signer and the integrity of the data can be 

verified. 

f. Electronic record means any combination of text, graphics, data, audio, pictorial, or 

other information representation in digital form that is created, modified, 

maintained, archived, retrieved, or distributed by a computer system. 

g. Electronic signature means a computer data compilation of any symbol or series of 

symbols executed, adopted, or authorized by an individual to be the legally binding 

equivalent of the individual's handwritten signature. 

h. Handwritten signature means the scripted name or legal mark of an individual 

handwritten by that individual and executed or adopted with the present intention 

to authenticate a writing in a permanent form. The act of signing with a writing or 

marking instrument such as a pen or stylus is preserved. The scripted name or 

legal mark, while conventionally applied to paper, may also be applied to other 

devices that capture the name or mark. 

i. Open system means an environment in which system access is not controlled by 

persons who are responsible for the content of electronic records that are on the 

system.    
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1.2  Subpart B. Electronic Records  

 

Sec. 11.10.  Controls for closed systems 

 
Person who use closed systems to create, modify, maintain, or transmit electronic records 

shall employ procedures and controls designed to ensure the authenticity, integrity, and, 

when appropriate, the confidentiality of electronic records, and to ensure that the signer 

cannot readily repudiate the signed record as not genuine. Such procedures and controls 

shall include the following: 

 

1. Validation of systems to ensure accuracy, reliability, consistent intended performance, 

and the ability to discern invalid or altered records. 

 

All records are stored in encrypted. Access is controlled by User Name and secret password.  

 

2. The ability to generate accurate and complete copies of records in both human readable 

and electronic form suitable for inspection, review, and copying by the agency. Persons 

should contact the agency if there are any questions regarding the ability of the agency to 

perform such review and copying of the electronic records. 

 

If the user of UV Lab Security software has the authority to save data, they can save it in its 

own file format. (*.gdt, *.kdt, *.bdt, *.qdt). This file includes experiment information, 

signature history and data modification history, etc. Audit trails (event log) may be printed 

to PDF file.   

 

3. Protection of records to enable their accurate and ready retrieval throughout the records 

retention period. 

 

The data created by UV Lab Security software is saved in the designated folders and these 

data can be read. The system owner must determine how the files will be archived and 

backup and have the procedure to ensure that retrieval records can be read. 

 

4. Limiting system access to authorized individuals. 

 

The only administrator can allocate who is authorized to access the system. It is possible for 

an administrator to give each user the authority to access the system in Microsoft Windows 
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7 Professional and Ultimate. To access the system, the user should be given a unique user 

name and secret password. The password cannot be viewed by anyone. All access or 

attempted access to the system is logged. Users are limited to a number of unsuccessful 

login attempts by Security Server SW. If the set number of unsuccessful logins is reached 

then the user is suspended. The User Name is reported to a log showing the unsuccessful 

login and their suspension. If a user forgets their password, the Security Server SW will 

allocate a new temporary password, which the user is forced to change on its first-time use.  

 

5. Use of secure, computer-generated, time-stamped audit trails to independently record 

the date and time of operator entries and actions that create, modify, or delete 

electronic records. Record changes shall not obscure previously recorded information. 

Such audit trail documentation shall be retained for a period at least as long as that 

required for the subject electronic records and shall be available for agency review and 

copying. 

 
Event log contains the User name, time stamp and all data log when the data file was 

created, modified or deleted, the new value, the old value, and the type of modification. 

Change to the data file do not obscure previously saved information. All logs can be review 

and printed for inspection purposes.  

 

6. Use of operational system checks to enforce permitted sequencing of steps and events, 

as appropriate. 

 
Enforced sequencing is carried out in the application. The system can be set up to enforce 

the carrying out of certain tasks to ensure correct sequencing. Examples of these are: 

running standards during an analysis, mandatory data entry and calibrating the instrument. 

 

7. Use of authority checks to ensure that only authorized individuals can use the system, 

electronically sign a record, access the operation or computer system input or output 

device alter a record, or perform the operation at hand. 

 

Security Server Software manages the authority to use the system and electronic signature 

for the electronic records. 

 

8. Use of device (e.g., terminal) checks to determine, as appropriate, the validity of the 

source of data input or operational instruction. 
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UV Lab will only read recognized PerkinElemer file formats. During installation the 

instrument serial number is recognized. Instrument model and serial number are stored with 

all data collected.  

 

9. Determination that persons who develop, maintain, or use electronic record/electronic 

signature systems have the education, training, and experience to perform their 

assigned tasks. 

 
It is the responsibility of customer and should be part of the system’s procedural 

compliance. Electronic or hardcopy documentation will be provided.  

 

10. The establishment of, and adherence to, written policies that hold individuals 

accountable and responsible for actions initiated under their electronic signatures, in 

order to deter record and signature falsification. 

 
It is the responsibility of customer and should be part of the system’s procedural compliance. 

 

11. Use of appropriate controls over systems documentation including: 

 
1) Adequate controls over the distribution of, access to, and use of documentation for 

system operation and maintenance. 

2) Revision and change control procedures to maintain an audit trail that documents time-

sequenced development and modification of systems documentation. 

 
It is the customer’s responsibility to maintain appropriate controls of the installed system 

and this should be part of the system’s procedural compliance. 

 
Sec. 11.30.  Controls for open systems 

 

Persons who use open systems to create, modify, maintain, or transmit electronic records 

shall employ procedures and controls designed to ensure the authenticity, integrity, and, as 

appropriate, the confidentiality of electronic records from the point of their creation to the 

point of their receipt. Such procedures and controls shall include those identified in 11.10, 

as appropriate and additional measures such as document encryption and use of 

appropriate digital signature standards to ensure, as necessary under the circumstances, 

record authenticity, integrity, and confidentiality. 
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The UV Lab Security software implementation requires the use of a closed system as we do 

not employ data encryption on our data files with this software. Windows 7 Professional/ 

Ultimate security is embedded in the UV Lab security software structure and security is set 

up through the Windows 7 security feature. The Windows log-in and password, in 

conjunction with the password reverification required when a user starts UV Lab, provide a 

way to control access to the UV Lab security software and a spectrophotometer. By 

following the guidelines in this document, you can achieve compliance with 21 CFR Part 11 

as it pertains to a closed system. 

 
Although data encryption is not used, the system administrator may choose to store the 

data in a secure folder such that only authorized users may access data according to their 

privileges. These privileges must be controlled by a unique user name and password 

combination.  

 
If compliance is desired in an open system, those responsible for maintaining system 

records must take adequate measures to ensure that UV Lab complies. 

 

 

Sec. 11.50.  Signature manifestations 

 

1. Signed electronic records shall contain information associated with the signing that 

clearly indicates all of the following: 

1) The printed name of the signer; 

2) The date and time when the signature was executed;  

3) The meaning (such as review, approval, responsibility, or authorship) associated with 
the signature. 

 
UV Lab security software implement as follows: 

1) The printed name is the User Name.  

2) The data and time are recorded. PerkinElmer users the PC’s log data format and 

includes time zone information.  

3) The meaning of each signature event is recorded and stored in the history record with 

the User Name of the signer. E-signatures are configurable and they are selected by the 

security server software. 

 



 

 PerkinElmer                                       Lambda 465 Security Software Guide  8  

2. The items identified in paragraphs 1a, 1b and 1c of this section shall be subject to the 

same controls as for electronic records and shall be included as part of any human 

readable form of the electronic record (such as electronic display or printout). 

  
The history record for the method or results stores this information. This record can be 

viewed on screen and printed. 

 

Sec. 11.70.  Signature/record linking 

 

Electronic signatures and handwritten signatures executed to electronic records shall be 

linked to their respective electronic records to ensure that the signatures cannot be excised, 

copied, or otherwise transferred to falsify an electronic record by ordinary means. 

  
The digital signature is stored in the same data file or report that is signed. Because the 

signature is stored in the same file as the electronic record, all digital signatures produced 

by UV Lab are directly linked to the electronic record. A check of an electronic record can 

verify whether the signature is valid. An invalid signature could be caused by a record that 

was never signed or a record that was modified after it was signed.  

 

1.3  Subpart C. Electronic Signatures  

  

Sec. 11.100.  General requirements 

 

1. Each electronic signature shall be unique to one individual and shall not be reused by, or 

reassigned to, anyone else. 

 
No two users can have the same User Name and secret password combination. 

 

2. Before an organization establishes, assigns, certifies, or otherwise sanctions an 

individual's electronic signature, or any element of such electronic signature, the 

organization shall verify the identity of the individual. 

 
It is the responsibility of the customer to include this as part of the system’s procedural 

compliance. 
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3. Persons using electronic signatures shall, prior to or at the time of such use, certify to 

the agency that the electronic signatures in their system, used on or after August 20, 

1997, are intended to be the legally binding equivalent of traditional handwritten 

signatures.  

1) The certification shall be submitted in paper form and signed with a traditional 

signature, to the Office of Regional Operations (HFC-100), 5600 Fishers Lane, Rockville, 

MD 20857. 

2) Persons using electronic signature shall, upon agency request, provide additional 

certification or testimony that a specific electronic signature is the legally binding 

equivalent of the signer’s handwritten signature. 

 

It is the responsibility of the customer to include as part of the system’s procedural 

compliance. 

 

Sec. 11.200.  Electronic signature components and controls 

 

1. Electronic signatures that are not based upon biometrics shall: 

1) Employ at least two distinct identification components such as an identification code 

and password. 

i. When an individual executes a series of signings during a single, continuous 

period of controlled system access, the first signing shall be executed using all 

electronic signature components; subsequent signings shall be executed using at 

least one electronic signature component that is only executable by, and designed 

to be used only by, the individual. 

ii. When an individual executes one or more signings not performed during a single, 

continuous period of controlled system access, each signing shall be executed 

using all of the electronic signature components. 

2) Be used only by their genuine owners; 

3) Be administered and executed to ensure that attempted use of an individual's 

electronic signature by anyone other than its genuine owner requires collaboration of 

two or more individuals. 

2. Electronic signatures based upon biometrics shall be designed to ensure that they cannot 

be used by anyone other than their genuine owners. 
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Digital signature used by UV Lab is based on the user’s ID and Password based on non-

biometrics.  

 

Sec. 11.300.  Controls for identification codes/passwords 

 

Persons who use electronic signatures based upon use of identification codes in 

combination with passwords shall employ controls to ensure their security and integrity. 

Such controls shall include: 

 
1. Maintaining the uniqueness of each combined identification code and password, such 

that no two individuals have the same combination of identification code and password. 

 
No two users can have the same User Name and secret password combination. When a 

user leaves the company the system will not allow that particular User Name to be reused 

by anyone else. This should be made part of the system’s procedural compliance. 

 
2. Ensuring that identification code and password issuances are periodically checked, 

recalled, or revised (e.g., to cover such events as password aging). 

 
UV Lab has the facility to allow password ageing. New passwords are checked according to 

the administrator settings for password ageing. The password aging intervals must be 

defined by the security server software an administrator and should be part of the system’s 

procedural compliance. 

 
3. Following loss management procedures to electronically de-authorize lost, stolen, 

missing, or otherwise potentially compromised tokens, cards, and other devices that 

bear or generate identification code or password information, and to issue temporary or 

permanent replacements using suitable, rigorous controls. 

 
The system allows an administrator to disable access via the compromised User Name. This 

should be part of the system’s procedural compliance. The system administrator can issue 

temporary and permanent replacement access 

 
4. Use of transaction safeguards to prevent unauthorized use of passwords and/or 

identification codes, and to detect and report in an immediate and urgent manner any 

attempts at their unauthorized use to the system security unit, and, as appropriate, to 

organizational management. 
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Regular review of the log is customer/client responsibility, and should be part of the system’s 

procedural compliance. 

 
5. Initial and periodic testing of devices, such as tokens or cards, that bear or generate 

identification code or password information to ensure that they function properly and 

have not been altered in an unauthorized manner. 

 
Devices such as tokens or cards are not used by UV Lab. 
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2. Security Program 
 

UV Lab Security Software is provided to run in Network PC and Local environment. This runs 

as service under Windows and enforces the security policies defined with the Security Server 

Program. UV Lab Security automatically tracks changes to data file. As mathematical 

processing or renaming occurs, the changes are saved in the data history information. It also 

handles the data history, method history and electronic signatures. The data used in UV Lab 

Security software is binary code based and cannot be opened in any other application software.  

 

1. Security Server software provides the functions for setting up the privilege and 

access control of application software, measurement method and etc. The audit trail 

function is included in the Event Viewer and each audit trail can be viewed.  

 

2. UV Lab security software is the program to run the Lambda 465 meeting the 

regulation of 21 CFR Part 11 for electronic records and electronic signatures.  
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II. Overview of Windows Administration 
 

1.  Basic Network concepts 
 

PerkinElmer Security Server software is designed to run in a networked or local 

environment. The security functionality of Security Server is fundamentally linked to the 

security features of your Windows network operation system. Understanding of some of 

the concepts and terms may give you more confidence in using the Security Server 

software. 

 

2.  Network Terms 
 

2.1  Server and Client 

 

A network server is a computer or device that provides information or services to other 

computers on a network. 

 

A client is the requesting program or user in a client-server relationship. 

 

Client-server describes the relationship between two computer programs in which one 

program, the client, makes a service request from another program, the server, which 

fulfills the request. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Network 
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2.2  Supported configurations 

 
You can use Security Server to set and enforce security policies in network: 

 

In the Network System, Security Server is installed on Windows 7 machine that is 

member of the domain. The client application is installed on multiple workstations that 

are members of the domain. The client workstations run Windows 7 Professional or 

Ultimate. 

 

In the stand-alone configuration (Local System), Security Server is installed and run 

along with the client application on a single non-networked computer that acts as both 

client and server. This computer runs Windows 7 Professional or Ultimate. Stand-alone 

configurations are intended for small laboratories with no network facilities.  
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III. Network System 
 
1.  Pre-Installation 

 

Before installing the UV Lab Application, the local administrator needs to designate 

users or groups and assign their authority of access. Users and Groups are designated 

in the Control Panel of the Windows Operating System. You need to set up user 

accounts in each computer in the workgroup, not just on a server. Each user must have 

the same user name on each computer in the workgroup. 

 

 

 

 

 

 

 

 

 

 

 

 

* Administrator account:  
- User account design  

(Refer to III-1.1 User Account Design) 
- Installation Security Sever software (Refer to III-2.1 

Installation of Security Server Software) 
- Check IP address (Refer to III-2.3 Setting IP address) 
- Setting Windows Firewall  

(Refer to III-2.5 Setting Windows Firewall 
- Run the Security Server Software  

(Refer to III-3 Operating Security Server Software) 

* User (Standard, Local) account:  

- Run the UV Lab security software (Refer to III-4 Operating UV Lab  
security software) 

* Administrator account:  

- User account design (Refer to III-1.1 User Account Design) 
- Installation of UV Lab and UV Lab security software (Refer to III-2.2  
Installation of UV Lab and UV Lab Security Software) 

- Setting the folder permission (Refer to III-2.4 Folder permissions) 
- Setting Windows Firewall (Refer to III-2.5 Setting Windows Firewall) 
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1.1 User Account Design  
 

Note: User Account design should be the same name on the Administrator account both in the 

Server and the Client computer.  

 

 

 

 

 

 

 

 

 Create the User account(s) in Windows 7  1.1.1
 

1. Log on to the computer as an administrator of server computer. 

 

2. Select Control Panel > User Accounts from the Start menu in the Windows 

operating System.  

 

3. Select Manage another account > Create a new account. 

 
 

4. Enter the Name (ex. user1) of the new account, select Standard user and click 

Create Account.  
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5. Verify the new account was created correctly.  

 

 

6. Additional accounts can be created in the same way as above. 
 

 
7. The procedure for creating user account is complete.  

 

8. Reboot and log on to the server computer as an administrator. 

 

9. Log on to the client computer as an administrator. Create the same user account as in 

the sever computer following procedure from #2 to #9. 
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2.  Software Installation 
 

2.1  Installation of Security Sever Software  
 
Note: Security Server Software should be installed on the Server computer. 
 
 
 
 
 
 
 

1. Log on to the Server computer as an Administrator account. 

 
2. Input the Security Server software CD into the CD drive. Security Server Software 

is installed automatically. The default installation folder is “C:\ SecurityServer”. 

 
3. If the automatic setup window is not shown, click Setup.exe in the CD. 

 
4. Security Server InstallShield Wizard starts. Click Next. 

 

 



  

19  Lambda 465 Security Software Guide                                        PerkinElmer 

5. Enter your information and Click Next. 

 

 

6. Click Next. 
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7. Click Anyone who uses this computer (all users). 

 

 

8. After the setup is complete successfully, click Finish.  

 

 

9. After the Security Server software installation is complete, the icon  will be 

created on the Desktop.  
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2.1.1 Security Server Software Interface 
  

Describes the unique display feature of security software. 

 
 
① Account: Control to set / change user account and password.  

② Software List: Register the software to be used (UV Lab). 

③ Account Control: Display the software function of the selected software in the 

Software List section. (File, Edit, Math, Measure, View, Math, etc.) 

④ Signature: Set electronic signature. (Default-Authorship, Resposibility, Approval, 

Review, etc.) 

⑤ Users, Groups: Select user account(s) to be given the access permission to each 

function in the Access control section.   

⑥ Users Group: Select user accunt(s) who will have the authority to apply each signature. 

 

▣ The Account menu includes commands to perform account functions as shown in the 

following table. 
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Add  

▣ Use the Add command to add a new user account. 

▣ Procedure 

1. To add a new user account, select a user account and enter a password. Click Add 

 

Note: Password must be of minimum 6 characters and include at least one letter and a number each. 

Note: When the new user logs on for the first time they will be forced to change their password.  

 

Deactivate/Activate 

▣ Use the Deactivate command to deactivate and prevent an activated user account 

from accessing the UV Lab software. 

▣ Use the Activate command to activate and allow a deactivated user account to access 

the UV Lab software. 

▣ Procedure 

1. To deactivate a registered user account, click the “Name” drop-down list in the 

“Deactivate account” section, and then the currently activated accounts are listed. 

2. Select the account to be deactivated and then click Deactivate. 

Command Function 

Add 

Deactivate/Activate 

Add new user account 

Deactivate or activate the user account 

Lockout Setting 

Unlock 

Set the lockout function  

Unlock the user account and set the new password 

Change Password Change the password of user account 
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3. To activate a registered user account out of deactivated accounts, click the “Name” 

drop down list in the “activate account” section, and then the currently deactivated 

accounts are listed. 

4. Select the deactivated account to be activated and then click Activate. 

 

 

Lock out Setting 

▣ Use the Lock out setting command to set the number of failed logins, lockout duration 

and password age. 
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a. Lockout: In executing the UV Lab security software, enter the limit number of failed 

logins. Once locked out, execute the Unlock function and set a new password. 

b. Lockout duration: Set the time when the UV Lab security software is closed in case 

that there is no action after it is executed. 

c. Password age: Set the password expiration (days). Alarm message is displayed from 3 

days before the password is expired. 

 

Unlock Account 

▣ Use the Unlock Account command to unlock the user account when user failed logins 

over the setting lockout number and to set a new password.  

▣ Procedure 

1. To unlock user account, select a user account and enter the new password and click 

unlock. 

 

 
Change Password 

Use the Change Password command to change the user account password.  

▣ Procedure 

1. To change password, select a user account and enter the new password and click OK. 
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2.2  Installation of UV Lab and UV Lab Security Software 

 
Note: UV Lab and UV Lab Security software should be installed on a client computer. 

 

1. Log on to a Client computer as an Administrator account.  

 
 
 
 
 
 
 
 

2. Input the UV Lab software CD into the CD drive. UV Lab software is installed 

automatically. The default installation folder is “C:\UV Lab”. 

Note: If UV Lab Software has already been installed, please skip the procedures #2~4 and then, UV 

Lab Security software only needs to be installed on a client computer. 

 

3. If the automatic setup window is not shown, click Setup.exe in the CD. 

4. After the UV Lab Software installation is complete, the UV Lab icon  will be 

created on the Desktop. 

Note: Refer to Lambda 465 Users Guide for more details of installing the UV Lab software. 

 

5. Input the UV Lab Security Software CD into the CD drive. Click Install.  

 

 

6. After the setup is complete successfully, click OK.  
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2.3  Setting IP address  

 
The IP Address of the Server computer should be addressed in the Client computer for 

networking as follows. 

 

2.3.1  Check the Server computer IP address  
 

1.  Log on to the Server computer as an Administrator account. 

 
 
 
 
 
 
 
 
 
 
 

 

2.  Press and hold the “Windows” key and then press the R key to open Run, and after 

writing “cmd", click OK.   

 

 

3.  Type “ipconfig” and press the Enter key.   
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4.  Check and make a note of the Server computer’s IP address: ex. 192.168.10.23  

 

 
2.3.2  Input the Server IP address information in the Client computer 

 

1.  Log on to a Client computer as an Administrator account.  

 

 

 

 

 

 

 

2.  Open the “C:\” directory, and click the “UV Lab” folder. Find and open the 

AccessControList.aci file on the notepad and type the Server IP address which is 

made a note of in chap. 2.3.1 Check the Server computer IP address instead of the 

currently set IP address. Click File and save the modified server IP address.  
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2.4  Folder permissions 

 
The Administrator account is already present on the PC. This gives the administrator full 

access to the whole system, including the ability to delete and rename files, and run any 

application, and change user and file/folder permissions.  

In order for data files to be protected, data saved in this protected folder can only be 

accessed by authorized users. This all permissions of file and folder follow the Windows 

system’s procedural compliance. 

 

2.4.1  Setting the “Write” permission to the “UV Lab” folder 
 

Note: User(s) should be granted the “Write” permission to run the UV Lab security software. To set 

up write access permission is carried out only on the Client computer’s Administrator account. 

 

1.  Log on to a Client computer as an Administrator account. 

 

 

 

 

 

 

 

2. Open the “C:\” directory, and right-click the “UV Lab” folder, and then click Properties. 

 

 

3. Select “Security” tab in the properties window and click Edit.  
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4. Select Users and check the Allow box for Write on the Permissions for Users 

window and click OK. 
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5. To allow a specific account (e.g. user 1) the write permission, not all Users, set as 

below.  

 

 

6. Select user1 and check the Allow box for Write on the Permissions for User1 

window and click OK. 
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2.4.2 Setting the “Delete and Change” prevention to the “UV Lab” folder  
 
 
NOTE: To prevent user from deleting or changing the UV Lab folder (C:\UV Lab) and its subfolders 

and files, the delete permission should be set as Deny. It can be set with Administrator’s 

account in the Client computer.  

 

1. Log on to a Client computer as an Administrator account. 

 

 

 

 

 

 

 

 

2. Open the “C:\” directory, and right-click on the “UV Lab” folder, and then click 

Properties. 

 

3. Select Security tab in the properties window and click Advanced. 
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4. Select the permissions tab and click Change Permissions.  

 

 

5. Select “user1” in the permissions window and click Edit. 
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6. Under permissions for Delete subfolders and files, Delete, Change permissions 

and Take ownership, select or check Deny and click OK. 

 

 

2.4.3 Setting the “Overwrite” prevention to the “Data” folder 
 

NOTE: To prevent user from overwriting data into the Data folder (C:\UV Lab \Data), the Create 

Folders /  append data permission should be set as Deny. It can be set with Administrator’s 

account in the Client computer. 

 
1. With the Administrator’s account logged on, open the “C:\ UV Lab” directory and right-

click on the “Data” folder and then click Properties. 
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2. Select Security tab in the properties window and click Advanced 

 

 

3. Select the permissions tab and click Change Permissions.  
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4. Select “user1” in the permissions window and click Edit. 

 
 

5. Under permissions for Create folders/ append data, select or check the Deny 

option for both and click OK. 

 

 

Note: The “Data” folder (C:\ UV Lab\Data) to save measurement data is designated as the default 

folder. If user wants to change the data folder, it can be changed referring to Chap. “IV-4-3. 

Path” in the UV Lab Software Users Guide in detail.  

Note: If the “Data” folder (C:\ UV Lab\Data) is changed to another folder, the permissions of Delete 

and Create Folders / append data to the folder should be set as Deny. 
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2.5  Setting Windows Firewall 

 
Windows Firewall is a program to prevent malicious software from gaining access to 

your PC through the Internet or a network. In the Network System, if the windows 

Firewall programs is turned on and the programs for UV Lab Security software are 

blocked, it should be set to allow the programs to communicate through the Windows 

Firewall. 

Note: In case that user uses other firewall programs, it should also be set to allow the programs 

for UV Lab Security software to communicate through those firewall programs. 

 

2.5.1  UV Lab access through the Windows Firewall  
 

 

 

 

 

 

 

 

1. Log on to the Server computer as an Administrator account. 

 

2. Select Control Panel from the Start menu in the windows operating system. (Check 

whether View by tap is set as Small icons. If not, change View by tap to Small 

icons.) And then click Windows Firewall. 

 

3. Click Allow programs to communicate through Windows Firewall. 
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4. Click “Change settings” and “Allow another program”. 

 

 

5. Click Browse… to find UV Lab.exe and select the UV Lab in the list. And click Add. 
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6. After selecting the UV Lab and check Home/Work (Private) and public, then click 

OK. 

 

 

7. Set to allow the Security Server software to communicate through Windows 

Firewall following procedures #5~6. 

 

8. Log on to a Client computer as an Administrator account.  

 

9. Referring to procedures #2~#6, it should be set to allow the UV Lab programs for 

security software to communicate through the Windows Firewall of the Client 

computer. 
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3.  Operating Security Server Software 
 

NOTE:  In the network system, to run the security program properly, the Administrator account of 

the Server computer should be kept logged-on.  

 

 

 

 

 

 

1. Run the Security Server Software. Then Security Server window will appear.  

 

 

2. In case that the message pops up as below, proceed with the following steps to get 

the administrator account logged-in propoerly.  

 

Note: The account has to be grouped in proper type, e.g., Administrator or Standard user (Local 

account). If the account is involved in unintended group like homeusers, the access to the 

software could be denied.  
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3. Open Start menu (or execute Run) and enter “netplwiz”. 
 

 
 

4. If the user is grouped in other than Administration, i.e., homeusers, select user and 

click Properties. 
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5. Select Group Membership and check Administrator. Click Apply and OK. 

 

 
6. Confirm the group is properly modified. After the following message appear, Click 

Yes to restart computer. 
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7. Despite all that, if accessing to Security Server is still denied, the unwanted group 

(homeusers) has to be deleted itself. Right-click on Computer and then click 

Manage. 

 

 

8. Open Groups in Local Users and Groups. 
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9. Select homeusers and click Delete icon. 

 

 

10. The following box will appear. Click Yes to delete homeusers group. 

Note: Other functions of windows system could be affected by deleting this homeusers group. 

Carefully consider the deletion. 

 

 

11. Restart the computer and execute the Security Server. 
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3.1  Set [Account Register] 

 
To perform UV Lab security software, user’s account(s) should be added in the Security 

Server program following the procedures below.  

 

1. Select Account of the Security Server window. Click Add. 

 

 

2. As the Add Account window appears, select account and set the password. Click Add.  

 
Note: Password must be of minimum 6 characters and include at least one letter and a number each. 

Note: When the new user logs on for the first time, they will be forced to change their password. 

 

3. The following message will appear, and then click OK.   
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4. Confirm the account was listed on Users, Groups.    

 

 
3.2  Set [Software List] 

 
In order to set Access Control for UV Lab security software functions, the software 

must be registered on the Software List in advance. Set the Software List as follows.  

 

1. Click Add in the Software List section of the Security Server window. 
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2. As the Open window appears, select UV Lab.afs and click Open. Then, the UV Lab 

will appear in the Software List.  

    

 
3.3  Set [Access Control] 

 

Access Control assigns users the authority to access various functions in the UV Lab 

security software. Set access controls as follows. 

 

1. Click on the UV Lab in the Software List. And then items are displayed in each section.  

 
Each ‘function’ corresponds to a menu item in the main menu of the UV Lab security 

software or a specific command. See the UV Lab software Users Guide for more details. 
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File : Allows user to access each command in the File menu. 

Edit : Allows user to access each command in the Edit menu. 

(cut, copy and paste function are not allowed) 

Measure : Allows user to access each command in the Measure menu. 

(Option and Instrument(Diagnostic) are allowed) 

View : Allows user to access each command in the View menu. 

Math : Allows user to access each command in the Math menu. 

Run : Allows user to access Run Blank and Run Sample commands for measuring 

samples and activates the associated shortcut keys. 

Method : Allows user to change parameters for sample measurement as set in the 

Method window. 

Validation : Allows user to access Validation functions. 

Validation Software is optional. Refer to the System Performance Validation 

Software for Lambda 465 for details. 

Accessory : Allows user to access available accessories choice and change their 

settings.  

Lamp : Allows user to access and change lamp settings. 

Instrument : Allows user to access the Instrument Ready Bar. 
 

2. Select the user account(s) to be given the access permission to each function and click 

. 
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3.4  Set [Signature Meanings] 

 

Set the signature meanings for users as follows.   

 

1. To create a new signature, click Add in the Security Server window. 

 

 

2. Enter the name for the new signature meaning and click Add. 
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3. The created signature meaning is shown in the Security Server window.   

 

  

4. Users for each signature are listed in the “Users, Groups” section. Select a signature 

and select users who will have the authority to apply the selected signature using  , 

 in the Users, Groups section. 
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4.  Operating UV Lab Security Software  
 

4.1  Starting UV Lab Security 

 

 

 

 

1. Log on to a client computer as a Standard user account. 

NOTE:  UV Lab security software cannot be executed under a Windows “Computer Administrator” 

account because the administrator account has the authority to modify and delete data.  

 

2. Execute the UV Lab security software. Then the “Log on to Security Server” message 

will appear. Enter the registered password of account and click OK. 
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3. If it is the first time to log on to UV lab security software, the following message will 

appear and click OK 

  

 

4. Enter the Old password (registration password) and New password, and then click OK.  

  

 

5. The following message will appear, and then click OK. 

 

 

6. A user’s access to each menu is determined by the privileges given to each user 

account. Taking user 1 for example, user 1 should be given access to execute the UV 

Lab security software with File, Method, Measure, Run in the Menu and with Review, 

Authorship and Responsibility in the signature menu. 

 

7. Open an existing sample data or measure the sample. Save the data.  

 
 

Note: If the data is not saved, signatures cannot be applied. Ensure that data is saved first. 

Note: Data must be saved in a folder which the user has been granted the access to. 
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8. Apply a signature to the measured or archived data by clicking Sign File in the File 

Menu or at the bottom of the window. 

 

 

 

9. In the Digital Signature dialog box, enter the user’s password, select the signature 

meaning, and click OK. 
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10. After the Signature is complete, the following message will appear, and then click OK. 

 
 

11. The signature record is shown at the bottom left-hand corner of the main screen and 

the signed data is saved as a new file. 
 

 

 

 

12. If the second signature happens to be applied to the data file, it is saved as a new file 

again as shown below. 

 

 

 

13. Click Print to view the saved data using a printed report as shown below. 
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4.2  Lockout for unattended operation  

 
This function is performing automatic lockout after some set time of inactivity. The 

automatic lockout time (Lockout duration) is set in the security server software by the 

administrator. If there is no action in the set time after the UV Lab security software is 

executed, it is locked out and the following message will appear. Enter the password to 

unlock the UV Lab security software again. 

 

Note: Your account is locked out when you exceed the limit number of failed logins and it can be 

unlocked by setting a new password by the administrator.   

 

4.3  Changing Methods  

 
If the Method is changed or data is modified in the signed file, user has to enter password 

to change methods.  

Ex: If you change the monitoring wavelength from 440, 465, 546, 590, 635 to 260, 361, 

450, 530, the ‘Reason of the changing method’ message box will appear as below.  

   

After typing the reason, click OK to save the changed data. The method change history 

could be checked in the print window. 
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4.4  Delete Spectra 

 
If a user deletes an acquired spectrum from the sample measurement result, it is 

mandatory to enter password in the ‘Reason of the deleting data’ message box. Deleted 

data is stored in the ‘Deleted Spectra’ folder as *.del file type. (C:\UV Lab\Deleted Spectra). 

 

 

4.5 Retrieve the deleted spectra and save it a new file 

 

1. In order to retrieve and re-analyze the deleted spectrum in the UV Lab security software, 

click Open in the menu and select the deleted file(*.del) in the ‘Deleted Spectra’ folder.   
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2. As the following message appears, click OK.  

 

 

3. Enter a file name and save it in the desired folder.  
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5.  Event Log 
 

NOTE: In the network system, Event Logs are shown in the server PC. 

 

 

 

 

 

The Logs of Changes are displayed in the Windows Event Viewer to trace the history of all the 

setup changes in the UV Lab Security software. 

  

1. Click Start > Control Panel > Administrative Tools. 

 

2. Select the Event Viewer. 

 
 

3. The Event View contents are displayed. Expand the Applications and Services Logs 

folder, and then select 21CfrPart11. 
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4. The event logs of the windows applications related to the UV Lab Security Software are 

listed in the 21CfrPart11 section. Select a particular event log in the list. 

 

 

5. You can see more detailed information (Username, software, event, date, time, etc.). 

The types of the events are described as follows.  

 

a)  Description of Security Server 

 
Added : means that an account is registered or authorized.  

Ex.) Username: user1, Added “user1” in the users list. 

Ex.) Username: user1, Added “user1” to “File” Access Permission. 

 

Deactivate/Activate : means that an account or authority is deactivate/activate. 

Ex.) Username: user1, Deactivated the user account: “user1” 

Ex.) Username: user1, Activated the user account: “user1”. 

 

Changed : means that the password or set the login information (Password expired 

etc.) is changed. 

Ex.) Username: user1, Changed the Lockout Setting. 

Username: user1, Changed the Password: “user1”. 
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Unlocked : means that user account is unlocked by administrator after locked out 

when user failed logins over setting lockout number. 

Ex.) Username: user1, Unlocked: “user1”. 

 

b)  Description of UV Lab 

 
Logon : means that the UV Lab security software is executed successfully. 

Ex.) Username: user1, LogOn: LOGON SUCCEEDED. 

Username: user1, Instrument is connected. S/N: 465K5081201, User ID: user1. 

Changed : means that the password or the login information is changed. 

Ex.) Username: user1, Password changed. 

 

Logon FAILED : means that the login is failed to execute UV Lab security software.  

Ex.) Username: user1, LogOn: LOGON FAILED. Incorrect password. The remaining 

allowable attempt number is 4. 

 

ReLogon : means that the UV Lab security software is executed again. 

Ex.) Username: user1, ReLOGON SUCCEEDED. 

 

ReLogon FAILED : means that the re-login is failed to execute UV Lab security 

software.  

Ex.) Username: user1, ReLOGON FAILED. Incorrect password. The remaining 

allowable attempt number is 4. 

 

Lockout : means that the UV Lab security software is locked out. 

Ex.) Username: user1, Software stops. Reason: Exceed the lock out duration time. 

 

Created : means that data is saved to a new file or a new data file is created. 

File: Ex.) Username: user1. The file “C:\UV Lab\Data\time.kdt” was created.  

Data: Ex.) Username: user1. The data “Sample1” was created. The file Untiled-1. 

 

Modified : means that the modified data is saved or it is saved as a different name. 

File: Ex.) Username: user1. The file “C:\UV Lab\Data\time2.kdt” was modified. The 

original file is “file “C:\UV Lab\Data\time.kdt” 

Data: Ex.) Username: user1. The data “Sample1 + 1.0000” was modified. The file 

C:\UV Lab\Data\data1.gdt. 
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Change : means that method is changed or data is modified. 

File: Ex.) Username: user1. Method is changed. Quant. Curve Order. Old:1, New:3. 

Data: Ex.) Username: user1. Dilution factor is changed, Old Factor:1, New Factor:0.5, 

Old result: 32.74, New result: 16.32, Sample name: Smaple2. 

 

Deleted : means that the sample data is deleted. 

Ex.) Username: user1. The data “sample 1” was deleted. The file C:\UV 

Lab\Data\data1.gdt. 

Username: user1. Reason of delete: test, Sample name : Sample 1. 

 

Signature : means that the electronic signature is signed. 

Ex.) Username: user1. The file “C:\UV Lab\Data\time.kdt” was signed.  

Reason : Review. 

 

Log off : means that the UV Lab security software is closed. 

Ex.) Username: user1, successfully exited or logged off the application.  

 

Wavelength recalibration : means that the wavelength is recalibrated. 

Ex.) Username : user1. “Wavelength Recalibration” calibration was performed. 

Instrument : Lambda 465, Serial number : 465K5050501 

 

Validation : means the instrument’s status (Wavelength, Photometric, Resolution,  

Stray Light, Stability, Dark Current), only in Validation software. 

Ex.) Username : user1. “ Validation : Dark” test was performed. Instrument: 

Lambda 465, Serial number : 465K5050501 
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IV. Local System 
 
1.  Pre-Installation 

 

Before installing the UV Lab Application, the administrator needs to designate users or 

groups and assign their authority of access. In the Local System, UV Lab security 

software with the security function can be run on a user account, not on the 

Administrator account. To set up account design and write access is possible only on 

the Administrator account in the Local System. 

 

 

 

 

 

 

 

 

 

1.1  User Account Design  

 

 Create the User account(s) in Windows 7 1.1.1
 

1. Log on to the computer as an administrator. 

 

2. Select Control Panel > User Accounts from the Start menu in the Windows 

operating System.  

 

* Administrator account:  
- User account design (Refer to IV-1.1 User Account Design) 
- Installation of Security Sever software & UV Lab and UV Lab 

Security Software (Refer to IV-2 Software Installation) 
- Setting the folder permission (Refer to IV-2.4 Folder Permissions) 
- Setting Windows Firewall (Refer to IV-2.5 Setting Windows Firewall) 
- Run the Security Server software (Refer to IV-3 Operating Security 

Server Software) 

* User account:  

- Run the UV Lab security software (Refer to IV-4 Operating UV 
Lab security software) 
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3. Select Manage another account > Create a new account. 

 
 

4. Enter the Name (ex. user1) of the new account, select Standard user and click 

Create Account.  

 

 

5. Verify the new account was created correctly. 

 

 

6. Additional accounts can be created in the same way as above. 
 

7. The procedure for creating user account is complete.  

 
8. Reboot and log on to the computer as an administrator. 
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2.  Software Installation 
 

In the local system you should install three separate software, Security Server, UV Lab 

and UV Lab security software on the Administrator account. However, the UV Lab 

security software is running only in the Standard User account.  

 

2.1  Installation of Security Sever Software  

 
1. Log on to the computer as an Administrator account. 

 
2. Input the Security Server software CD into the CD drive. Security Server Software is 

installed automatically. The default installation folder is “C:\ SecurityServer”. 

 
3. If the automatic setup window is not shown, click Setup.exe in the CD. 

 
4. Security Server InstallShield Wizard starts. Click Next. 
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5. Enter your information and Click Next. 

 

 

6. Click Next. 
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7. Click Anyone who uses this computer (all users). 

 

 

8. After the setup is complete successfully, click Finish.  

 

 

9. After the Security Server software installation is complete, the icon  will be 

created on the Desktop. 
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2.1.1 Security Server Software Interface 
  

Describes the unique display feature of security Software. 

 
 
① Account: Control to set / change user account and password.  

② Software List: Register the software to be used (UV Lab). 

③ Account Control: Display the software function of the selected software in the 

Software List section. (File, Edit, Math, Measure, View, Math, etc.) 

④ Signature: Set electronic signature. (Default-Authorship, Resposibility, Approval, 

Review, etc) 

⑤ Users, Groups: Select user account(s) to be given the access permission to each 

function in the Access control section.   

⑥ Users Group: Select user accunt(s) who will have the authority to apply each signature. 

 
▣ The Account menu includes commands to perform account functions as shown in the 

following table. 
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Add  

▣ Use the Add command to add a new user account. 

▣ Procedure 

1. To add a new user account, select a user account and enter a password. Click Add. 

 

Note: Password must be of minimum 6 characters and include at least one letter and a number each. 

Note: When the new user logs on for the first time they will be forced to change their password. 

 

Deactivate/Activate 

▣ Use the Deactivate command to deactivate and prevent an activated user account 

from accessing the UV Lab software. 

▣ Use the Activate command to activate and allow a deactivated user account to access 

the UV Lab software. 

▣ Procedure 

1. To deactivate a registered user account, click the “Name” drop-down list in the 

“Deactivate account” section, and then the currently activated accounts are listed. 

  

Command Function 

Add 

Deactivate/Activate 

Add new user account 

Deactivate or activate the user account 

Lockout Setting 

Unlock 

Set the lockout function  

Unlock the user account and set the new password 

Change Password Change the password of user account 
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2. Select the account to be deactivated and then click Deactivate. 

 

3. To activate a registered user account out of deactivated accounts, click the “Name” 

drop down list in the “activate account” section, and then the currently deactivated 

accounts are listed. 

4. Select the deactivated account to be activated and then click Activate. 

 

 

Lock out Setting 

▣ Use the Lock out setting command to set the number of failed logins, lockout duration 

and password age. 
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a. Lockout: In executing the UV Lab security software, enter the limit number of failed 

logins. Once locked out, execute the Unlock function and set a new password. 

b. Lockout duration: Set the time when the UV Lab security software is closed in case that 

there is no action after it is executed. 

c. Password age: Set the password expiration (days). Alarm message is displayed from 3 

days before the password is expired 

 

Unlock Account 

▣ Use the Unlock Account command to unlock the user account when user failed logins 

over the setting lockout number and to set a new password.  

▣ Procedure 

1. To unlock user account, select a user account and enter the new password and click 

unlock. 

 
 

Change Password 

Use the Change Password command to change the user account password.  

▣ Procedure 

1. To change password, select a user account and enter the new password and click OK. 

 
 



 

 PerkinElmer                                       Lambda 465 Security Software Guide  70  

2.2  Installation of UV Lab and UV Lab Security Software 

 
1. Log on as an Administrator account.  

 

2. Input the UV Lab software CD into the CD drive. UV Lab software is installed 

automatically. The default installation folder is “C:\UV Lab”. 

Note: If UV Lab Software has already been installed, please skip the procedures #2~4 and then, UV 

Lab Security software only needs to be installed on a computer. 

 

3. If the automatic setup window is not shown, click Setup.exe in the CD. 

4. After the UV Lab Software installation is complete, the UV Lab icon  will be 

created on the Desktop. 

Note: Refer to Lambda 465 Users Guide for more details of installing the UV Lab software. 

 

5. Input the UV Lab Security Software CD into the CD drive. Click Install. 

 

 

6. After the setup is complete successfully, click OK.  
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2.3  Setting IP address  

 

Open the “C:\” directory, and click the “UV Lab” folder. Open the AccessControList.aci 

file on the notepad and save the modified IP address as 127.0.0.1. 
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2.4  Folder permissions  

 
The Administrator account is already present on the PC. This gives the administrator full 

access to the whole system, including the ability to delete and rename files, and run any 

application, and change user and file/folder permissions.  

In order for data files to be protected, data saved in this protected folder can only be 

accessed by authorized users. This all permissions of file and folder follow the Windows 

system’s procedural compliance 

 

2.4.1  Setting the “Write” permission to the “UV Lab” folder 
 
NOTE: User(s) should be granted the “Write” permission to run the UV Lab security software. To set 

up write access permissions is carried out only on the Administrator account. 

 

1. Open the “C:\” directory, and right-click the “UV Lab” folder, and then click 

Properties. 
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2. Select “Security” tab in the properties window and click Edit. 

 

 

3. Select Users and check the Allow box for Write on the Permissions for Users window 

and click OK. 
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4. To allow a specific account (e.g. user 1) the write permission, not all Users, set as 

below.   

 

 

5. Select user1 and check the Allow box for Write on the Permissions for User1 

window and click OK. 
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2.4.2  Setting the “Delete and Change” prevention to the “UV Lab” folder 
 

NOTE: To prevent user from deleting or changing the UV Lab folder (C:\UV Lab) and its subfolders 

and files, the delete permission should be set as Deny. It can be set with Administrator’s 

account. 

 
1. Open the “C:\” directory, and right-click the “UV Lab” folder, and then click 

Properties. 

 

2. Select Security tab in the properties window and click Advanced. 

 

 

3. Select the permissions tab and click Change Permissions.  
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4. Select “user1” in the permissions window and click Edit. 

 

 

5. Under permissions for Delete subfolders and files, Delete, Change permissions 

and Take ownership, select or check the Deny option for both and click OK. 
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2.4.3 Setting the “Overwrite” prevention to the “Data” folder 
 

NOTE: To prevent user from overwriting data into the “Data” folder (C:\UV Lab\Data), the Create 

Folders /  append data permission should be set as Deny. It can be set with Administrator’s 

account. 

 
1. With the Administrator’s account logged on, open the “C:\ UV Lab” directory,  

and right-click on the “Data” folder and then click Properties. 

 

2. Select Security tab in the properties window and click Advanced 
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3. Select the permissions tab and click Change Permissions. 

 

 

 

4. Select “user1” in the permissions window and click Edit. 
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5. Under permissions for Create folders/ append data, select or check the Deny 

option for both and click OK. 

 

 

 

Note: The “Data” folder (C:\ UV Lab\Data) to save measurement data is designated as the default 

folder. If user wants to change the data folder, it can be changed referring to Chap. “IV-4-3. 

Path” in the UV Lab Software Users Guide in detail.  

Note: If the “Data” folder (C:\ UV Lab\Data) is changed to another folder, the permissions of 

Delete and Create Folders / append data to the folder should be set as Deny. 
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2.5  Setting Windows Firewall 

 
Windows Firewall is a program to prevent malicious software from gaining access to 

your PC through the Internet or a network. If the windows Firewall programs is turned 

on and the programs for UV Lab Security software are blocked, it should be set to allow 

the programs to communicate through the Windows Firewall. 

NOTE: In case that user uses other firewall programs, it should also be set to allow the programs for 

UV Lab Security software to communicate through those firewall programs. 

 

2.5.1  UV Lab access through the Windows Firewall  
 

1. Log on as an Administrator account.  

 

2. Select Control Panel from the Start menu in the windows operating system. (Check 

whether View by tap is set as Small icons. If not, change View by tap to Small 

icons.) And then click Windows Firewall. 

 

3. Click Allow programs to communicate through Windows Firewall. 
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4. Click “Change settings” and “Allow another program”. 

 

 

5. Click Browse…to find UV Lab.exe and select the UV Lab in the list. And click Add. 
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6. After selecting the UV Lab and check Home/Work (Private) and public, then 

click OK. 

 

 

7. Set to allow the Security Server software to communicate through Windows 

Firewall following procedures #5~6. 

  



  

83  Lambda 465 Security Software Guide                                        PerkinElmer 

3.  Operating Security Server Software 
 

NOTE: In the Local system, to run the security program properly, the Administrator account of the 

computer should be kept logged-on. 

1. Run the Security Server Software.  Then Security Server window will appear.  

 
 

 

2. In case that the message pops up as below, proceed with the following steps to get 

the administrator account logged-in propoerly.  

 

Note: The account has to be grouped in proper type, e.g., Administrator or Standard user (Local 

account). If the account is involved in unintended group like homeusers, the access to the 

software could be denied. 
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3. Open Start menu (or execute Run) and enter “netplwiz”. 

 

 

4. If the user is grouped in other than Administration, i.e., homeusers, select user and 

click Properties. 
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5. Select Group Membership and check Administrator. Click Apply and OK. 

 

 

 
6. Confirm the group is properly modified. After the following message appear, Click 

Yes to restart computer. 
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7. Despite all that, if accessing to Security Server is still denied, the unwanted group 

(homeusers) has to be deleted itself. Right-click on Computer and then click Manage. 

 

 

8. Open Groups in Local Users and Groups. 

  

 

9. Select homeusers and click Delete icon. 
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10. The following box will appear. Click Yes to delete homeusers group.  

Note: Other functions of windows system could be affected by deleting this homeusers group. 

Carefully consider the deletion. 

 

 

11. Restart the computer and execute the Security Server. 

 
 

3.1  Set [Account Register] 

 
To perform UV Lab security software, user’s account(s) should be added in the 

Security Server program following the procedures below.  

 

1. Select Account of the Security Server window. Click Add. 
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2. As the Add Account window appears, select account and set the password. Click Add.   

 
Note: Password must be of minimum 6 characters and include at least one letter and a number each. 

Note: When the new user logs on for the first time they will be forced to change their password 

 

3. The following message will appear, and then click OK.   

 

 
4. Confirm the account was listed on Users, Groups.   

 

 



  

89  Lambda 465 Security Software Guide                                        PerkinElmer 

3.2  Set [Software List] 

 
In order to set Access Control for UV Lab security software functions, the software 

must be registered on the Software List in advance. Set the Software List as follows.  

 

1. Click Add in the Software List section of the Security Server window. 

 

 

2. As the Open window appears, select UV Lab.afs and click Open. Then, the UV Lab 

will appear in the Software List.  
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3.3  Set [Access Control] 

 

Access Control assigns users the authority to access various functions in the UV Lab 

security software. Set access controls as follows. 

 

1. Click on the UV Lab in the Software List. And then items are displayed in each section.  

 
Each ‘function’ corresponds to a menu item in the main menu of the UV Lab security 

software or a specific command. See the UV Lab software User Guide for more details. 

File : Allows user to access each command in the File menu. 

Edit : Allows user to access each command in the Edit menu. 

(cut, copy and paste function are not allowed) 

Measure : Allows user to access each command in the Measure menu. 

(Option and Instrument(Diagnostic) are allowed) 

View : Allows user to access each command in the View menu. 

Math : Allows user to access each command in the Math menu. 

Run : Allows user to access Run Blank and Run Sample commands for measuring 

samples and activates the associated shortcut keys. 

Method : Allows user to change parameters for sample measurement as set in the 

Method window. 

Validation : Allows user to access Validation functions. 

Validation Software is optional. Refer to the System Performance Validation 

Software for Lambda 465 for details. 
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Accessory : Allows user to access available accessories choice and change their 

settings.  

Lamp : Allows user to access and change lamp settings. 

Instrument : Allows user to access the Instrument Ready Bar. 
 

 
2. Select the user account(s) to be given the access permission to each function and click 

. 
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3.4  Set [Signature Meanings] 

 

Set the signature meanings for users as follows.   

 

1. To create a new signature, click Add in the Security Server window. 

 

 

2. Enter the name for the new signature meaning and click Add. 

 
 

3. The created signature meaning is shown in the Security Server window.   
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4. Users for each signature are listed in the “Users, Groups” section. Select a signature 

and select users who will have the authority to apply the selected signature using  , 

 in the Users, Groups section. 
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4.  Operating UV Lab Security Software 

 

4.1  Starting UV Lab Security 

 
1. Log on to Windows as a standard user account. 

 

NOTE: UV Lab security software cannot be executed under a Windows “Computer Administrator” 

account because the administrator account has the authority to modify and delete data.  

 

2. Execute the UV Lab security software. Then “Log on to Security Server” message will 

appear. Enter the registered password of account and click OK. 

 

 

3. If it is the first time to log on to UV Lab security software, the following message will 

appear and click OK 
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4. Enter the Old password (registration password) and New password, and then click OK.  

  

 

5. The following message will appear, and then click OK. 

 

 

6.  A user’s access to each menu is determined by the privileges given to each user 

account. Taking user 1 for example, user1 should be given access to execute the UV 

Lab security software with File, Method, Measure, Run in the Menu and with Review, 

Authorship and Responsibility in the signature menu. 

 

7. Open an existing sample data or measure the sample. Save the data.  

 
 

Note: If the data is not saved, signatures cannot be applied. Ensure that data is saved first. 

Note: Data must be saved in a folder which the user has been granted the access to. 
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8. Apply a signature to the measured or archived data by clicking Sign File in the File 

Menu or at the bottom of the window. 

 

 

 

9. In the Digital Signature dialog box, enter the user’s password, select the signature 

meaning, and click OK. 
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10. After the Signature is complete, the following message will appear, and then click OK. 

 

 

11. The signature record is shown at the bottom left-hand corner of the main screen and 

the signed data is saved as a new file. 
 

 

 

 

12. If the second signature happens to be applied to the data file, it is saved as a new file 

again as shown below. 
 

 

 

 

13. Click Print to view the saved data using a printed report as shown below. 
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4.2  Lockout for unattended operation  

 
This function is performing automatic lockout after some set time of inactivity. The 

automatic lockout time (Lockout duration) is set in the security server software by the 

administrators. If there is no action in the set time after the UV Lab security software is 

executed, it is locked out and the following message will appear. Enter the password to 

unlock the UV Lab security software again. 

 

Note: Your account is locked out when you exceed the limit number of failed logins and it can be 

unlocked by setting a new password by administrator. 

 

4.3  Changing Methods  

 
If the Method is changed or data is modified in the signed file, user has to enter password 

to change methods.  

Ex: If you change the monitoring wavelength from 440, 465, 546, 590, 635 to 260, 361, 

450, 530, the ‘Reason of the changing method’ message box will appear as below.  

   

After typing the reason, click OK to save the change data. The method change history 

could be checked in the print window. 
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4.4  Deleting Spectra 

 
If a user deletes an acquired spectrum from the sample measurement result, it is 

mandatory to enter password in the ‘Reason of the deleting data’ message box. Deleted 

data is stored in the ‘Deleted spectra’ folder as *.del file type. (C:\UV Lab\Deleted Spectra) 
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4.5 Retrieve the deleted spectra and save it as a new file 

 

1. In order to retrieve and re-analyze the deleted spectrum in the UV Lab security software, 

click Open in the menu and select the deleted file(*.del) in the ‘Deleted Spectra’ 

folder.   

 

 

2. As the following message appears, click OK.  

 

 

3. Enter a file name and save it in the desired folder.  
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   5.  Event Log 
 

The Logs of Changes are displayed in the Windows Event Viewer to trace the history of all the 

setup changes in the UV Lab Security software. 

  

1. Click Start > Control Panel > Administrative Tools. 

 

2. Select the Event Viewer. 

 
 

3. The Event View contents are displayed. Expand the Applications and Services Logs 

folder, and then select 21CfrPart11. 
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4. The event logs of the windows applications related to the UV Lab Security Software are 

listed in the 21CfrPart11 section. Select a particular event log in the list. 

 

 

5. You can see more detailed information (Username, software, event, date, time, etc.). 

The types of the events are described as follows.  

 

a) Description of Security Server 

 
Added : means that an account is registered or authorized.  

Ex.) Username: user1, Added “user1” in the users list. 

Ex.) Username: user1, Added “user1” to “File” Access Permission. 

 

Deactivate/Activate : means that an account or authority is deactivate/activate. 

Ex.) Username: user1, Deactivated the user account: “user1” 

Ex.) Username: user1, Activated the user account: “user1”. 

 

Changed : means that the password or set the login information (Password expired 

etc.) is changed. 

Ex.) Username: user1, Changed the Lockout Setting. 

Username: user1, Changed the Password: “user1”. 
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Unlocked : means that user account is unlocked by administrator after locked out 

when user failed logins over setting lockout number. 

Ex.) Username: user1, Unlocked: “user1”. 

 

b)  Description of UV Lab 

 
Logon : means that the UV Lab security software is executed successfully. 

Ex.) Username: user1, LogOn: LOGON SUCCEEDED. 

Username: user1, Instrument is connected. S/N: 465K5081201, User ID: user1. 

Changed : means that the password or the login information is changed. 

Ex.) Username: user1, Password changed. 

 

Logon FAILED : means that the login is failed to execute UV Lab security software.  

Ex.) Username: user1, LogOn: LOGON FAILED. Incorrect password. The remaining 

allowable attempt number is 4. 

 

ReLogon : means that the UV Lab security software is executed again. 

Ex.) Username: user1, ReLOGON SUCCEEDED. 

 

ReLogon FAILED : means that the re-login is failed to execute UV Lab security 

software.  

Ex.) Username: user1, ReLOGON FAILED. Incorrect password. The remaining 

allowable attempt number is 4. 

 

Lockout : means that the UV Lab security software is locked out. 

Ex.) Username: user1, Software stops. Reason: Exceed the lock out duration time. 

 

Created : means that data is saved to a new file or a new data file is created. 

File: Ex.) Username: user1. The file “C:\UV Lab\Data\time.kdt” was created.  

Data: Ex.) Username: user1. The data “Sample1” was created. The file Untiled-1. 

 

Modified : means that the modified data is saved or it is saved as a different name. 

File: Ex.) Username: user1. The file “C:\UV Lab\Data\time2.kdt” was modified. The 

original file is “file “C:\UV Lab\Data\time.kdt” 

Data: Ex.) Username: user1. The data “Sample1 + 1.0000” was modified. The file 

C:\UV Lab\Data\data1.gdt. 
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Change : means that method is changed or data is modified. 

File: Ex.) Username: user1. Method is changed. Quant. Curve Order. Old:1, New:3. 

Data: Ex.) Username: user1. Dilution factor is changed, Old Factor:1, New Factor:0.5, 

Old result: 32.74, New result: 16.32, Sample name: Smaple2. 

 

Deleted : means that the sample data is deleted. 

Ex.) Username: user1. The data “sample 1” was deleted. The file C:\UV 

Lab\Data\data1.gdt. 

Username: user1. Reason of delete: test, Sample name : Sample 1. 

 

Signature : means that the electronic signature is signed. 

Ex.) Username: user1. The file “C:\UV Lab\Data\time.kdt” was signed.  

Reason : Review. 

 

Log off : means that the UV Lab security software is closed. 

Ex.) Username: user1, successfully exited or logged off the application.  

 

Wavelength recalibration : means that the wavelength is recalibrated. 

Ex.) Username : user1. “Wavelength Recalibration” calibration was performed. 

Instrument : Lambda 465, Serial number : 465K5050501 

 

Validation : means the instrument’s status (Wavelength, Photometric, Resolution,  

Stray Light, Stability, Dark Current), only in Validation software. 

Ex.) Username : user1. “ Validation : Dark” test was performed. Instrument: 

Lambda 465, Serial number : 465K5050501 
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